
4.0WinASPE 4.0 is a new application and will

not upgrade previous versions of this pro-

gram. If you are using version 3.x or ear-

lier, please rename the WinASPE folder on

your hard drive (i.e. Old WinASPE) before

installing this new version.

Note: If there are participants/grantees

that have active grants and you need to

revise, modify, or cancel their insurance,

please use the version of WinASPE that

they were originally enrolled under.

For Technical Support, Call (202) 619-4943
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U S D E P A R T M E N T O F S T A T E

The application on the enclosed CD and diskette (WinASPE 4.0) is designed to
simplify and speed the enrollment of USDOS program participants in the
Accident and Sickness Program for Exchanges (ASPE). WinASPE will help you

enter the data needed to enroll participants. Copy the data to a 3.5” diskette and mail it
to USDOS at the address listed on the last page of these instruction sheets or send the
enrollment data via e-mail to: monitor@eca.state.gov.

This program will also print the appropriate personal information on the provided ASPE
identification cards; and as an added benefit, you can use it to store participant data for
your own records. USDOS uses the data you provide to maintain a unified database of par-
ticipants covered by this program and to transmit enrollment information to the Third Party
Administrator, Outsourced Administrative Systems, Inc. (OASYS).

To use this PC-based application, you will need:
1. a PC (Pentium or better recommended) running Windows 95, Windows 98, or 

Windows NT,
2. a hard disk with approximately 20-MB free space,
3. a 3.5” diskette drive, and
4. a CD Rom drive.

To print ASPE insurance identification cards, you will need:
1. a windows supported printer (HP Laser compatible recommended).

To send the information back to USDOS, you will need:
1. one blank, formatted 3.5” diskette, or
2. an e-mail account with Internet access.

WinASPE includes guidance (for most fields) on the last line of the screen. If you have
questions or need further assistance, please call ECA-Executive Office at 202-619-4943.

Installation
Getting Started

The WinASPE CD includes an installation utility. This utility will copy files (programs and data) from
the CD to the directory that you specify on your computer’s hard drive. The installation utility may be
mailed to you on CD and/or diskettes, or you can download it from the Internet at
http://exchanges.state.gov/aspe/. Do not put www in front of the exchanges.state.gov/aspe/.

• 3/4 down the page on the left is the Single file download for ver. 4.0 of WinASPE and the Activation
key.

• There is a user name and password, which must be entered to download the files. The username is
aspe

• The password is salut (both words are lowercase).

• Save the single file download to your hard drive (make sure you remember where you save it).

• Insert a floppy into the A drive and click on the word Activation, and follow the instructions.

• After you have finished both downloads, close your browser and use windows explorer or My
Computer to find the WinASPE application. At this time you can either leave the floppy containing
the aspe.ini file in your drive, or eject it. (WinASPE will prompt you to insert the floppy during
installation.) Double-click the WinASPE application to start the installation process.

• Once done you are ready to run the program.

If your computer does not

have a CD Rom drive,

please contact USDOS -

Executive Officer (202)

619-4943 and a set of

diskettes will be mailed to

you. If your computer

does not have any of these

capabilities, please contact

your USDOS program offi-

cer.You will be sent an

alternate means of

enrolling participants in

the ASPE Insurance

Program.
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If you are installing the

WinASPE program on more

than one computer you must

have a new activation key

(aspe.ini) file. Please contact

USDOS-Executive Office at

(202) 619-4943 if you need

additional files or you can

download the file from the

internet at

http://exchanges.state.gov/ASPE 

U S D E P A R T M E N T O F S T A T E

To install WinASPE
• Place the WinASPE CD in your CD drive.
• Place the floppy disk with the aspe.ini file in the A drive.
• On your desktop double-click the icon My Computer, CD drive, then WinASPE icon.
• Follow the instructions on the screen during the installation process. When the installation is com-

plete you will need to launch the WinASPE program.
• You can access the program from the start menu, or double-click on My Computer, C drive, the

WinASPE folder and WinASPE icon. 

Unless you delete the WinASPE program from your hard drive when you finish data entry, you can
enroll new participants at any time without reinstalling the software. To restart WinASPE, select the
Programs option from the Start menu, and then select the WinASPE option from the USDOS menu, or go
to C:/Program Files/WinASPE.

Information about your organization
Identify your organization

When you run the application for the first time, the WinASPE will prompt you to select the organiza-
tion that you represent. There are three organization classifications:

Private Sector Program Agency
USIS Post or Fulbright commission
U.S. Government Agency.

Select the option that best describes your organization. Once you make a selection, a list of organiza-
tions of that type is displayed. After you select the name of your organization from the list, WinASPE
stores your selection and will not prompt you for it again.

You can search for an organization by typing its name in the “Select Your Organization” box, or by
using the PageUp, PageDown, and the arrow keys to scroll through the list. When your organization is
highlighted, click on the “OK” button to select it. WinASPE will include this information with each
enrollment record that you submit.

If your organization is not on the list, click the Add button. When you have typed your organization’s
name, press TAB to move to the organization’s id column. Enter the id number supplied to you by
USDOS, (if you were not given an organization id, please call ECA–Executive Office at (202) 619-4943
to be issued a number) then press TAB to save the new record. When this is complete, highlight your
organization in the updated list then click on the “OK” button to select it.

This completes the start-up procedures and brings you to the Main WinASPE window. Unless you
reinstall WinASPE in the future, you will be taken directly to this window when you start it the next time.

WinASPE Enrol lment Instruct ions–3



Identify your program officials
After identifying your organization, you need to enter basic information about the program officers in

your organization who will be responsible for the projects administered. This information will appear on
the participant identification card as “Name of Auth. Prog. Official”. To add this information, select the
“Program Officers” option from the Navigation Tree or from the Edit menu. The navigation tree is located
in the upper left of the screen. The right side of the screen now displays a grid where you can enter your
Program Officers’ names and phone numbers.

Main window
There are four basic options available in the WinASPE program. These options can be selected from

the Navigation Tree on the left side of the Main Window, or they can be accessed from the File and Edit
menu options. When you select one of the options, the right side of the window will change to display the
properties associated with that option.

Maintain insurees
Use this option to add information about new participants whom you wish to enroll in the USIA

Accident and Sickness Program, or to modify/delete information about program participants already
enrolled.

U S D E P A R T M E N T O F S T A T E
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Navigating the insuree form 
When you select the Insuree Maintenance option, you will see a list of all the participants that you

have entered information for. You can:

INSERT Add a new participant
ENTER Change information on the highlighted participant
ALT-B Switch to the Browse List of existing participants
ALT-D Switch to the Details view for the selected participant
CRTL-D Add a new participant with information from the highlighted record
CTRL-F Use Find to locate a Participant record
F8 Mark selected record to Reprint the identification card
F9 Mark selected record to be exported to USIA
DELETE Delete the highlighted participant

From the Browse window you can also click on one of the column headers to change the sort order of the list.

Adding/modifying
Once you are in the Details view, enter the information requested in each field and press TAB to pro-

ceed to the next field or SHIFT-TAB to move to the previous field. Use the PageUp and PageDown keys
to move to a different page on the form. Follow the instructions on the status line (the last line of the
screen) until you reach the end of the form or have entered all relevant information. In some instances
you cannot proceed until you have entered the required information. Press CTRL-S at any point in the
form to save your work.

Assistance
If you encounter difficulties while entering participant information, please refer to Helpful Hints while

Entering Information on page 6.

Export insurees
The export feature gives you 2 methods of transmitting your participant information back to USDOS:
1. copy participant information onto a 3.5” diskette to mail to USDOS, or 
2. create a file that you can attach to an e-mail message and send to USDOS.

U S D E P A R T M E N T O F S T A T E
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If you are entering multiple participants with similar information, you can save time by using the “Create
Duplicate Insuree” feature. Enter and save the information for the first participant, then press the CTRL-
D keys to create a new record using the information from the previous record as a starting point. You can
then change any information that needs to be different and save the record.



Although you have the choice of sending your participant information to USDOS via e-mail or 3.5”
diskette, we urge you to use the e-mail as it is much more safe and efficient. Data on your program offi-
cers is not exported.

How to export data 
WinASPE prompts you to place a blank, formatted diskette in a drive on your PC and to enter the

name of that drive (usually A or B). Once you confirm the drive, WinASPE copies new participant data to
the diskette. You should mail the diskette to: 

Cindy Malecki
U.S. Department of State
ECA-IIP/EX/S  (ASPE Insurance)
301 4th Street SW, ROOM 534
Washington, DC 20547

To send a file by e-mail, you will be prompted to fill in the following information: 
a. Your e-mail address (this is used to notify you when we receive your enrollments), and
b. The name of the file you wish to send to us (you must give your export file a file name, preferably

something like “myfile.txt”—all export files must end in .txt
(If you do not specify a directory path with the name, the file will be found in the C:\WinASPE direc-

tory.) 

New/updated records 
Only new records and records that have been updated since the last export are copied to the diskette.

Therefore, you must mail all export disks to USDOS. If you export records on Jan. 1 and Jan. 3, but mail
only the Jan. 3 disk, USDOS will receive only the new records and the records changed between Jan. 1
and Jan. 3.

Print insurance cards for insurees 
WinASPE will print the appropriate information on the ASPE Insurance Enrollment cards supplied to

you USDOS.

How to print 
Insert the blank card stock into your printer. Blank WinASPE identification cards may be ordered

from USDOS (202) 619-4943. Select the Print Cards option from Navigator Tree in the upper left corner

U S D E P A R T M E N T O F S T A T E
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If you choose to send enrollments by e-mail, you must send your export file (e.g. myfile.txt) via your e-mail
service to monitor@eca.state.gov. WinASPE creates the e-mail file but does not transmit it automatically.
You must transmit this file as a separate step. If you do not receive a message acknowledging receipt of
your e-mail within 48 hours, please contact 202-619-4943 for assistance.



of the screen, or the Print option from the File menu . All participants who have not had a card printed
will be displayed in the resulting Insuree list. If there are participants in the list that you do not want to
print, just uncheck the box under the “Print?” column by clicking on it. (All highlighted participants will
be printed.) Once you are satisfied with your selections, select either Preview to Screen or Send to Printer
for the Output Destination, then click on the Print button to begin the process. Once WinASPE has sent
the cards to your printer, you will be asked if the information printed successfully or not. Clicking “Yes”
will mark all of the selected Participants as being printed; clicking “No” will leave them marked as
unprinted.

Reprinting cards
After a record has been printed, WinASPE will mark the record as Printed. If you test the print func-

tion on photocopied cardstock (or make a mistake in printing) and need to reprint a participant’s informa-
tion, highlight the record in the Participant Maintenance Browse view and press the F8 key to reset their
“Printed” flag. When you go back to the Print Cards option, the participant will appear in the list of
insurees that need to be printed.

Print setup 
Due to variations in printer alignment and the pre-printed Insurance Card Stock, the information on

your cards may not line up precisely. Fortunately, the alignment options can be easily adjusted by select-
ing the Print Setup option from the File menu. From here you can adjust all aspects of the Insurance
Card layout. A brief explanation of what these settings mean follows (all measurements are in inches):

• Cards Down a Page is the number of cards that appear vertically down each page. 

• Cards Across a Page is the number of cards that appear horizontally across each page. 

• Card Height is the height of an individual card.

• Card Width is the width of an individual card. 

• Distance From Top of Page to First Card is the distance from the top edge of the page to the top of 
the first card. 

• Distance From Left Edge of Page to First Card is the distance from the left edge of the page to the
left edge of the first columns of cards.

• Distance From the Top of one Card to Top of Next is the distance from the top edge of one card to the
top edge of the next card below it.

• Distance From the Left of One Card to Left of Next is the distance form the left edge of one card to
the left edge of the next card to the right of it.

Caution
USDOS supplies only enough cardstock to print one card per participant. We suggest you photocopy

the blank card stock to test the print function before inserting card stock.

Program officers
Use this option to add the names of your Authorized Program Officials or modify the information you

entered during start-up. This option functions in the same way as the participant option. WinASPE shows
you a scrolling list of program officers, and you add, modify or delete information by pressing INSERT or
by highlighting a name and using the appropriate keys.

Helpful hints while entering information
General

While we hope that the WinASPE application is intuitive, several items may need a word of explanation.

Participant last name 
Our Third Party Administrator (OASYS) sorts enrollee records alphabetically by last name. If a partici-
pant has two surnames (e.g. Arturo Delgado Campana), you should enter both the first and second last
name in this field. Be sure to have the names listed in the same order on the 1D card as they will be list-
ed in the system.

USDOS Program office
Select the USDOS office that is handling the participant’s program (e.g. E/AEN for Fulbright programs

in North Africa, the Near East and South Asia). The office symbol is also included in the USDOS grantW
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number as the first characters before the “-.”  If you do not know the program office, please call your
USDOS program officer.

Project number 
For group projects, enter the USDOS grant number. We use this information to link group project par-

ticipants with one another and participants with project information in the EVDB database.

Subject/discipline 
Select the subject term that best describes program content for this participant. Be as specific as pos-

sible. Note that WinASPE maintains a different list of terms for different USDOS program offices. If the
list does not include a relevant theme, contact your USDOS program officer.

Coverage dates
Coverage Dates are explained on page 20 of the ASPE booklet, and again in the General Policy

Statement (contact your USDOS program officer). USDOS will not be responsible for losses sustained out-
side the coverage dates as outlined in the General Policy Statement and ASPE booklet, even if the
grantee is successfully enrolled in violation of the terms of this program. Grantee organizations may be
responsible for these losses. No USDOS program officer may modify the enrollment period as described
in the General Policy Statement without the concurrence of the Executive Director and the Bureau of
Educational and Cultural Affairs.

Notes
Use this space (the large text field on the NOTES page) to record all dates for which coverage is not

provided (see page 20 of the booklet). This includes any trips out of country of assignment, personal trav-
el, travel other than direct travel to and from the country of assignment-directly prior to and after a
USDOS program.

U S D E P A R T M E N T O F S T A T E

W
in

A
S

P
E

Please mail diskettes containing ASPE participants to:
Cindy Malecki
U.S. Department of State
ECA-IIP/EX/S (ASPE Insurance)
301 4th Street SW, Room 534
Washington, DC 20547

E-mail address for exporting participants is: monitor@eca.state.gov

For technical assistance, please call: Cindy Malecki (202) 619-4943

A group project (e.g., a regional IV program or a citizen-exchanges project) is an exchange activity designed
for a specific group of participants (usually 1-20) that takes place on specific dates (e.g., August 3-September
3), at specific locations (e.g., Chicago, Los Angeles and Denver), for a specific purpose. By contrast, an indi-
vidual project (e.g., an academic assignment) is designed for a single individual. Many USIA/USDOS pro-
grams (e.g., Fulbright student exchanges or youth exchanges) consist of a series of such individual projects.
In those cases, leave the “Grant/Project #” field blank.
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